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INTRODUCTION

This document has been created to introduce the FHA Connection to prospective users of
the FHA Connection. System requirements, security, applications available are listed,
customer help facilities are detailed, and Internet and FHA navigation are explained.

What is the FHA Connection?

In accordance with President Clinton's established National Performance Review of 1993
to develop and implement strategies to make the Federal government more efficient, more
responsive to customers, and less costly to taxpayers, FHA established "The FHA
Connection". The FHA Connection is an interactive system on the Internet that gives
approved FHA lenders real-time access to FHA systems for the purpose of conducting
official FHA business in an electronic fashion.

With the concept of speed and ease of use in mind, the FHA Connection was designed
with help screens for every process within the system. This allows the user to receive help
immediately. If the question has not been sufficiently answered by the help screen, an
email address and help line telephone number have been included for more difficult
problems (see FHA Connection User Assistance).

GETTING STARTED

System Requirements

To access the FHA Connection you must have the following:

• A personal computer, workstation, or terminal with access to the Internet via a
modem or network through an Internet Service Provider (ISP).

• An Internet web browser that is SSL compliant. (Netscape 2.02 or higher version,
or Microsoft’s Internet Explorer 3.0 or higher are two such browsers that have
been successfully used with the FHA Connection.)

Security

The FHA Connection uses the Secure Socket Layer (SSL)
communications protocol to ensure data security. SSL
incorporates data encryption to protect data transmitted between
an FHA Connection user’s terminal and the HUD Internet server.
SSL is the open standard for secure transactions on the World
Wide Web. To use the FHA Connection, therefore, the Internet
browser software you use must be SSL compliant.
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HUD has also subscribed with a commercial firm to provide authentication to the user that
they are indeed talking to HUD. The system involves the use of server side certificates
which assure the user that they are indeed communicating with the HUD website. This
prevents the creation of an illegal mirror website designed to steal information.

In addition to the Web site being secure, each user is required to have an unique user ID
to access the FHA Connection. This requirement ensures that only authorized individuals
can view and modify information relating to a particular lender's data. ID’s are to be
requested and used by individual users. Lenders should be aware and should advise their
staff that it is unlawful to intentionally, without authorization, access a Federal
Department computer or a Federal interest computer for unauthorized purposes and that
an officer or employee of a lender who knowingly misuses an ID may be subject to a fine
and/or imprisonment in accordance with 18 U.S.C. 1030.

NAVIGATING THE INTERNET

The FHA Connection has been designed to operate in
conjunction with the popular World Wide Web browsers used
by millions of users of the Internet. Understanding the features
and functions of an Internet Web browser will enable users to
easily navigate the various applications found on the FHA
Connection.

Features and functions of web browsers include: browser
window, title bar, menu bar, toolbar buttons, location bar,
scroll bars, status bar, links, buttons on pages, and the ability to search for key words. For
your convenience, a brief overview of these features are provided in the Appendices under
Internet Web Browsers.

As you become familiar and comfortable with your specific browser, you will be able to
configure the browser to your own specifications. Some users set the default location of
their browser to the FHA Connection home page, others set a bookmark to the location.

You will find that the Print options available through the browser work very nicely to
create hard copies of the desired screens.
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OBTAINING FHA CONNECTION USER ID’S

Application Coordinator ID’s

The two types of FHA Connection User ID’s
are: Application Coordinator ID and standard
ID.

Each mortgagee at the corporate level must
designate up to two Application Coordinators
prior to requesting standard ID’s. The
mortgagee's Application Coordinators will be
responsible for supplying authorization for the
different applications that are available on the
FHA Connection to each employee. This is
accomplished through the FHA Connection's ID
Maintenance window which will only be
accessible to the Application Coordinators. The
Application Coordinators are able to give
employees of their company access to the
different applications (e.g. Case Query,
Appraiser Reassignment, Insurance processing,
etc.) and remove IDs.

To obtain an Application Coordinator's ID, the
designated Application Coordinator must
complete the FHA Application Coordinator
Registration form that resides on the FHA
Connection's web site. A maximum of two
Application Coordinator IDs may be issued per
lender at the corporate level.

Each Application Coordinator will need to
provide:

Name
Social Security Number
Organization Name
Mortgagee ID
E-mail address
Mother's Maiden Name
Desired Password
Type of System Access Needed

Application Coordinator Registration
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To register with the FHA Connection for an Application Coordinator user ID:

1. Start your web browser application by either double clicking on its icon, or
selecting it from the Start menu.

2. Click once in the Location bar. The current address (or URL) should be
highlighted.

3. Type in https://entp.hud.gov/clas and press e. The FHA Connection main
page displays.

4. Click on . The Welcome to the FHA Connection page displays.

5. Read through the page and select the Application Coordinator Registration
link. The Application Coordinator Registration page displays.

6. Read and fill out the application.

? Make sure that you remember your password.

7. When all of the information has been entered, click on  at the bottom of
the screen. To start over, click on .

After successfully completing the form, the system will
generate a FHA Connection User ID that will be mailed
to the address of the President/CEO of the lending
institution that is currently on file with FHA. The
President/CEO will then communicate the assigned
Coordinator User ID to the individual that requested the
ID. If the President/CEO determines that it would not be
appropriated to forward this ID, they should contact their
Homeownership Center (HOC) to have the ID deleted.

Notification Letter
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Standard User ID’s

Once the lending institution has obtained an
Application Coordinator ID, the system will
allow other employees within that organization
to request standard ID’s for themselves.
Employees accomplish this through the FHA
Connection ID Registration form. They will have
to indicate that they are requesting a standard
user ID, and provide similar information as the
Application Coordinator. After successfully
completing the registration form, the FHA
Connection will generate an ID. The Application
Coordinator will then be able to retrieve the ID's
from the system and grant the proper
authorizations for each new user ID.

? The Application Coordinator will not
have access to your password.

Each application for a standard user ID will need
to provide:

Name
Social Security Number
Organization Name
E-mail address
Mother's Maiden Name
Desired Password
Type of System Access Needed

To register with the FHA Connection for a Standard User ID:

1. Start your web browser application by either double clicking on its icon, or
selecting it from the Start menu.

2. Click once in the Location bar. The current address (or URL) should be
highlighted.

3. Type in https://entp.hud.gov/clas and press e. The FHA Connection main
page displays.

4. Click on . The Welcome to the FHA Connection page displays.

Standard User Registration
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5. Read through the page and select the Standard User Registration link. The
Standard User Registration page displays.

6. Read and fill out the application.

? Make sure that you remember your password. The Application
Coordinator will not have access to this information.

7. When all of the information has been entered, click on  at the bottom of
the screen. To start over, click on .

Although the process for a Standard User ID requires the assistance of the Application
Coordinator, the Application Coordinator does not have access to the password of the
individual who is applying for the user ID. Passwords will only be reset by calling the
HOC (see FHA Connection User Assistance).

STARTING A SESSION ON THE FHA CONNECTION

Once you have received your user ID and password, you will be able to enter the FHA
Connection.

To enter the FHA Connection:

1. Start your web browser application by either double clicking on its icon, or
selecting it from the Start menu.

2. Click once in the Location bar. The current address (or URL) should be
highlighted.

3. Type in https://entp.hud.gov/clas and press e.

4. Your browser displays the FHA Connection home page. Click on .
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5. A prompt screen displays and requests your user ID
and password. For security reasons, asterisks
display in the Password field as you type in your
password. Once you have entered your user ID and
password, click on .

? The password field of the login window is case
sensitive. This means that you must type the password in exactly as it is
spelled, capitalizing all letters that require capitalization. The @ being
active is commonly the culprit of a failed authorization.

MENUS AND SCREENS

The FHA Connection is the umbrella over FHA applications available using the Internet.
The menus for the FHA Connection divide the web site into five major sections: Single
Family Origination, Single Family Servicing, Lender Approval, HMDA Data Submissions,
and Neighborhood Watch.

The three types of screens within the FHA Connection are: menu, input, and output.

Menu Screens

Menus are lists of the screens and
functions that are accessible from the
current screen. The names of the screens
and functions are formatted as links to the
appropriate screen or function. A link is
like a door to the listed screen. To go to a
certain screen, click on the screen name
with the mouse and the browser goes to
that screen.

Login Window

FHA Approval Lists Menu
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Input Screens

An Input screen is any screen that requires
you to enter any form of information. This
can be as simple as an FHA number, or as
complex as defining the criteria of a
specific query. For example, if you were
searching for a list of all active male,
Hispanic appraisers in Washington, DC,
you would select Appraisers from the FHA
Approval Lists menu. Once the screen
displays, you select the fields with the
mouse and enter the data by either
selecting the appropriate selection from a
list, or typing in the criteria. The important
fields to fill in for this query would be the
race, gender, status, state, and city fields.

Output Screens

Output screens are the results of any query
or request for information. The information
returned usually displays in table format.
For a hard copy of the information, the
results can be sent to a printer.

All screens have links to the previous
menus. These links are located in the
bottom left-hand corner of the screen. The
links are represented by pictures and text,
and can be activated by clicking on the
picture or text with the mouse.

Being a work in progress, the menus and
headings within the FHA Connection will
change as services are added and
improved.

Appraisers Input Screen

Application Results Screen
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FHA Connection Web Buttons

At the bottom of each screen in the FHA Connection, a row of buttons have been added
to link to the previous screen and menus. These links allow you to navigate to the root
menus with one click of the mouse instead of having to click on the Back button several
times to reach the same menu.

In order to report any operational problems or ask questions not answered by the Help
page, an email address has also been added to each page. To send an email to the
administrator of the system, simply click on the address to launch the browser’s built-in
email program.

To send a message to the system administrator:

1. Click on the <SF Administration> link at the bottom of the screen. The email
screen displays.

2. The address of the administrator automatically displays in the Mail To: field.
To send a copy of this message to another person or persons, click in the Cc:
field and enter the additional addresses.

3. Click in the Subject field and enter the message you want to display as the
subject of the message.

4. Click in the main window at the bottom of the screen and enter the body of the
message.

5. Once the message has been completed, click on  at the top of the window.

Once the message has been sent, please allow sufficient time for the system administrator
to respond to your message, and/or correct any problems.

Email Screen
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CUSTOMER ASSISTANCE

Help

Help screens have been
consistently placed throughout
the FHA Connection. A help

icon is located on each window to assist
the user. The help screen will brief the
user on the functions, valid data entries,
the data entry fields, and the information
that will be returned.

The help screens should be consulted
prior to calling FHA for help with the
data entry fields.

FHA Connection User Assistance

If you have questions regarding the data fields, screens, or menus that have not been
answered by the help screens, you can email FHA at sfadmin@hud.gov or call your HOC.
Below are the HOC phone numbers and the states/territories they support.

Atlanta (1-888-696-4687)

Alabama
Caribbean
Florida
Georgia
Illinois

Indiana
Kentucky
Mississippi
North Carolina
Puerto Rico

South Carolina
Tennessee
Virgin Islands

Philadelphia (215-656-0578)

Connecticut
Delaware
District of Columbia
Maine
Maryland
Massachusetts

Michigan
New Hampshire
New Jersey
New York
Ohio
Pennsylvania

Rhode Island
Vermont
Virginia
West Virginia

Inspectors Help
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Denver (1-800-543-9378)

Arkansas
Colorado
Iowa
Kansas
Louisiana
Minnesota

Missouri
Montana
Nebraska
New Mexico
North Dakota
Oklahoma

South Dakota
Texas
Utah
Wisconsin
Wyoming

Santa Ana (1-888-827-5605)

Alaska
Arizona
California

Guam
Hawaii
Idaho

Nevada
Oregon
Washington

For premium problems and information about premiums, the telephone number of the
Mortgage Insurance Accounting and Servicing is (703) 235-8117.

For problems with FHA Connection user IDs and passwords, call your HOC.
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APPENDICES

Applications

Single Family Origination

The Single Family Origination menu contains all of the primary screens involved in the
loan origination process.

Single Family Origination Menu

Case Processing

The screens necessary to process an FHA case from initial application through
endorsement are included in the Case Processing menu.

Case Number Assignment

Establish a New Case

The Case Number Assignment screen “Establish a New Case” allows
lenders to establish a new case in the Computerized Home Underwriting
Management System (CHUMS). Before a case number is assigned, the
Credit Alert Interactive Voice Response System (CAIVRS) will check the
Social Security Numbers of the applicants and CHUMS will check the
property address for duplicates. If there are no problems, CHUMS will
issue the case number. Problems concerning case number assignment will
be handled by the appropriate Field Office/HOC.

Update Existing Case

Once the FHA case number has been assigned, the lender, its agent, or
sponsor may correct the data captured at assignment anytime before the
case is insured by accessing the Case Number Assignment screen "Update
Existing Case” with the FHA case number and their lender ID.
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Holds Tracking

The Case Number Assignment screen “Holds Tracking” allows lenders to
monitor cases that have been held by the Field Office for further review.
Cases are held for a variety of reasons including duplicate address or lender
hold. Lenders should frequently review the status of the cases that are
being held.

Appraisal Logging

The Appraisal Logging screen allows lenders to log appraisal information
which is a prerequisite to insurance processing. Appraisal information may
be corrected on this screen before the case is insured. Once the case has
been insured, lenders may only access the Appraisal Logging screen to
query the appraisal information.

Insurance Application

The Insurance Application screen allows lenders to add, review, or change
insurance application data for a case prior to endorsement. The screen is
divided into five sections: Fundamental Case Information, General
Information, Mortgage Credit Worksheet Information, Borrower
Information, and Mortgage Information.

For the following types of errors, an error message will be passed to the
lender so that the error can be corrected before the case binder is submitted
for insurance:

Monthly Payment Error
Maturity Date or Term of Loan Error
First Payment Date or Closing Date Error
MIP Error
Underwriter Error
Loan to Value Error
Investor Unit Error
Condo or Subdivision Error
Compliance Inspection Error
MIP Penalties Due Error

If an error has been detected by the system, the Error(s) Detected field will
list the error message explaining the problem. This feature should eliminate
most Notices of Return (NORs).
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HECM Insurance Application

The HECM Insurance Application screen allows a lender to access or input
a borrower's Home Equity Conversion Mortgage (HECM) insurance
application data. Once the information has been processed, if authorized, a
lender may add, review, or change information.

Appraiser Reassignment

The Appraiser Reassignment screen allows lenders to override the initial
appraiser assignment. An appraisal may be reassigned for a variety of
reasons, including: the current appraiser is on vacation, medical leave or
otherwise unavailable, the current appraiser has too many other cases on
hand, location convenience, or to further equitable distribution. An
appraiser may only be assigned to a case if the appraiser is licensed in the
state where the property is located. To reassign a case to another appraiser,
the lender must know the FHA case number, and the current and new
appraisers' IDs.

Borrower/Address Change

The Borrower/Address Change screen allows lenders to access the
complete Borrower/Address Change screen to review and, until the case is
insured, update data previously entered on the Case Number Assignment or
the Insurance Data screens. Errors discovered after insurance must be
corrected by the Field Office/HOC.

CAIVRS Authorization

The CAIVRS Authorization screen lists any information regarding default,
claim, judgment, or foreclosure reported on an applicant’s past government
loans or guarantees through the following agencies: the Department of
Education (ED), HUD, the Department of Justice (DOJ), the Small
Business Administration (SBA), the United States Department of
Agriculture (USDA), and the Department of Veterans' Affairs (VA). Up to
10 CAIVRS records may be returned for each Social Security Number
(SSN) entered.

Case Cancellation

The Case Cancellation screen allows lenders to end further processing of a
case if it will not proceed to closing, for example, if the homeowner
decides not to sell his/her property, the borrower switches to a
conventional loan, or the borrower changes his/her mind.
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A case may be canceled by the lender unless a Firm Commitment has been
issued or the case has been insured.

Case Query

The Case Query screen lists general case information regarding the
property address, case type, appraiser, Mortgage Insurance Premium
(MIP), and insurance status. The lender may request the status of a specific
loan as it progresses through the FHA mortgage process.

Case Transfer

The Case Transfer screen allows a case to be transferred between lenders
when a loan application is transferred from one lender to another. The
transfer request must be initiated by the lender or sponsor/agent currently
recorded in CHUMS. The lender's sponsor/agent may be corrected using
this screen as well.

Duplicate MIC

The Duplicate Mortgage Insurance Certificate (MIC) screen allows a
request for duplicate MICs to be previewed or the duplicate MIC to be
printed at the Field Office and mailed to the lender. A duplicate MIC
(HUD-59100) may only be issued for a case that has been endorsed and
has had an original MIC previously printed. Prior to receiving the duplicate
MIC form, the lender will be able to review the information on the screen
as it will appear on the form once it has been processed. The duplicate MIC
lists general case information regarding the mortgage, mortgagee,
mortgagor, property address, borrower type, and automated data
processing (ADP) code.

Inspector Assignment

The Inspector Assignment screen allows lenders to initially assign an
inspector, to log a compliance inspection, reassign an inspector, and enter
or update case information. The lender may assign an inspector to the case
once it has been processed through the Case Number Assignment screen.
Lenders will not be able to continue to request insurance on proposed
construction cases if this screen has not been completed. After insurance,
the lender may only update this screen if the case was insured under
Section 203(k).

Refinance Authorization

The Refinance Authorization screen allows lenders to access the Upfront
Mortgage Insurance Premium (UFMIP) information for Refinance cases.
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This information includes the used and refundable amounts of the UFMIP
from the old case. The listed information is for a two month period, the
indicated month and the following month, and is based on the closing date
entered. An authorization number and an expiration date will be issued
when the exchange of information is verified and posted.

FHA Approval Lists

Appraiser Selection by Lender

The Appraiser Selection by Lender screen allows users to view the
distribution of appraisals, showing the percentage of appraisals by gender
and minority status within the lending organizations. These percentages can
be compared to the lender roster of appraisers. These percentages are listed
beside the information for the individual branch, and shows the availability
of appraisers by status within the field office. The appraisal information can
be sorted by field office code, lender name, lender city, or lender state. The
search can be narrowed by entering additional criteria. For example, if you
wanted to know the percentage of minority men selected in Residential
Bancorp in Columbus, OH, the important fields to fill would be the Field
Office, lender name, lender city, and lender state fields. To search a smaller
area, the Field Office code and lender state could be used.

Appraiser Approval List

The Appraisers screen allows users to search for appraisers by location,
name, license, race, gender, or status. The search can be configured to find
specific types of appraisers through the use of the pull down menus and
entry fields. For example, if the search was for all active male, Hispanic
appraisers in Washington, DC, the important fields to fill would be the
race, gender, status, state, and city fields. To search a smaller area, the ZIP
code and Field Office code could be used.

Condominium Approval List

The Condominiums screen allows users to search for condominium
projects by location, name, or status. The search can be configured to find
specific types of projects through the use of the pull down menus and entry
fields. For example, if the search was for all rejected projects in Lexington,
KY, the important fields to fill would be the state, city, and status fields. To
search a smaller area, the ZIP code and Field Office code could be used.

GSA Lists

This link branches to the U.S. General Services Administration’s (GSA)
web site’s List of Parties Excluded from Federal Procurement and
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Nonprocurement Programs. This list is issued monthly and identifies those
parties excluded throughout the U.S. Government (unless otherwise noted)
from receiving Federal contracts or certain subcontracts and from certain
types of Federal financial and non-financial assistance and benefits. The List
of Parties Excluded from Federal Procurement and Nonprocurement
Programs is maintained by GSA for the use of Federal programs and
activities. The List of Parties is structured in accordance with a
recommendation from the Interagency Committee on Debarment and
Suspension.

Inspector Approval List

The Inspectors screen allows users to search for inspectors by location, ID,
name, or status. The search can be configured to find specific types of
inspectors through the use of the pull down menus and entry fields. For
example, if the search was for all active inspectors in Washington, DC, the
important fields to fill would be the state, city, and status fields. To search
a smaller area, the ZIP code and Field Office code could be used.

Limited Denial of Participation

This is a link to FHA’s limited denials of participation on HUD’s Web
page. It is a listing of all parties which have had an action taken by a HUD
Field Office or the Deputy Assistant Secretary for Single Family (DASSF)
or Multifamily (DASMF) Housing which excludes a party from further
participation in a HUD program area.

Mortgage Limits Listing

This is a link to FHA’s maximum mortgage limits on HUD’s Web page. It
is a listing of the FHA single family mortgage limits. This listing is
downloaded from the Department's Computerized Home Underwriting
Management System every Wednesday. Since mortgage limits are updated
constantly by local HUD office staff, please contact the Single Family
Housing Director in your local HUD office for current information.

Planned Unit Developments (PUDs) Approval List

The PUDs screen allows users to search for PUDs by location, PUD ID,
name, or status. The search can be configured to find specific types of
projects through the use of the pull down menus and entry fields. For
example, if the search was for all projects in Lexington, KY, the important
fields to fill out would be the state and city fields. To search a smaller area,
the ZIP code and Field Office code could be used.
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Underwriter Registry

The Underwriter Registry screen allows lenders to add, change, or
terminate an underwriter record in CHUMS. When a lender adds an
underwriter, an underwriter ID is issued by the FHA Connection. Lenders
may change an underwriter's information, including name, mailing address,
and employment information, but may not change the underwriter's ID or
SSN. Lenders may terminate an underwriter when the underwriter leaves
its employ. If an underwriter hired by a new lender has an active ID (e.g.
was not terminated by the previous employer), the new lender may still
change the underwriter's information to reflect the underwriter's current
employment status.

ZIP Codes

The Zip Codes screen allows users to search for ZIP codes by Field Office,
state, city, county code, or county name. The search can be used to find the
Field Office location information by entering the ZIP code. For example, if
the search was to find the ZIP code for the Field Office responsible for
Leesburg, VA, enter and submit the location information. To find which
Field Office is responsible for a given ZIP code, enter and submit the ZIP
code.

Single Family Servicing

The Single Family Servicing menu contains all of the primary screens involved in servicing
an FHA loan.

Single Family Servicing Menu
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Claims Processing

Title Approval Status

The Title Approval Status screen provides current information about
completed title approvals on requested cases. Either a single title approval
record may be requested (by its FHA Case Number) or multiple records
may be requested. Lenders will be able to view and print the title approval
data for any case they service that has been issued a computer generated
title approval letter. These screen prints will satisfy requirements to
document claim files with title approval letters.

Delinquent Loans

Lender’s Information

The Monthly Delinquent Loan Report screen allows users to submit
delinquent loan information that is required to register with the system.
This is a one time procedure. Once registered, the information can be
retrieved by clicking on the Retrieve button. The error report generated
from the Reporting Delinquent Cases screen will be sent to the email
address that is entered on this screen.

Reporting Delinquent Cases

The Monthly Delinquent Loan Report screen allows the lender to enter
delinquent loan information. This is a one time procedure per FHA case
number. Once entered, the case information can be retrieved by entering
the FHA case number and clicking on the Retrieve button.

Monthly Premiums

HUD's Single Family Insurance Operations Division (SFIOD) provides electronic
access to the files listed below. With these files, you can determine the cases in
your mortgagee portfolio, monthly premiums due, and any discrepancies in the
billing-payment process. Your FHA Connection user ID limits the files to only the
information you have the right to access.

? Billing, Lender Notification, Reconciliation, and Refund Transaction files will
not be available until the implementation of the Single Family Premium
Collection System (SFPCS) Periodic.

• Advance Notices
• Billing
• Lender Notification
• Portfolio
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• Reconciliation
• Refund Transaction

The files can be viewed on screen or copied (downloaded) to your computer
system. Files viewed on screen can be printed through the Internet software you
are currently using (e.g., Netscape Navigator). Files downloaded to your computer
system are compressed or "zipped". After a file has been downloaded, it must be
uncompressed in order to view and manipulate the information. After you have
downloaded and unzipped files, you may format them in a software package such
as Microsoft Excel, Microsoft Access, Lotus 1-2-3, or dBase.

Portfolio

The Portfolio screen provides current information on requested cases.
Either a single case may be requested (by its FHA Case Number) or
multiple cases may be requested. The results can be viewed on your screen
and printed to your printer using your Internet software.

Retrieve Files

The Monthly Premiums screen allows the user to retrieve pregenerated
files. Advance Notices, Billing, Reconciliation, and Refund Transaction
files are available to view or download at any time. The latest three files for
each type are shown under the Ready list on the Retrieve Files screen.

Mortgage Record Changes

Servicer/Holder Transfer (HUD Form 92080)

The Servicer/Holder Transfer screen allows a user to process a servicer
and/or holder transfer for a selected case. Transfers should be reported for
update as soon as possible.

Assumption (HUD Form 92080)

The Assumption screen allows a user to process a mortgagor assumption
for a selected case. Assumptions should be reported for update as soon as
possible.

Insurance Termination (HUD Form 27050-A)

The Termination screen allows a user to process a mortgage insurance
termination for a selected case. Terminations should be reported as soon as
possible.
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Lender Approval

The Lender Approval menu links to screens for maintaining data about the lending
institution, its branches, and affiliate relationships (e.g. sponsor/loan correspondents)
relating to the Title II mortgage insurance programs or the Title I home improvement
program.

Lender Approval Menu

Institution Profile

This function allows lenders to correct HUD’s records on the following
institution data: the corporate office’s street, mailing, and Internet
addresses; phone and fax numbers; the officer who should be addressed in
HUD correspondence; and the name being used if the company is operating
under a name other than its legal name (i.e. a dba). The first screen in this
function displays summary information about the institution such as name,
number of active branches, and FY of last recertification. The detail screen
allows lender employees, authorized by the company’s FHA Connection
Application Coordinator, to correct most of the institution data. You must
still write to HUD’s Lender Approval and Recertification Division for
changes to the company’s legal name; the state in which it is located;
mortgagee type; or the combination of single family & multifamily,
origination, and servicing functions the company is authorized to perform
(see Frequently Asked Questions for further details).

Branch Functions

These functions allow lenders to register new branches (after remitting the
required application fee); correct address, phone, dba and other
information about existing branches; and terminate branches that have
closed or stopped processing FHA loans. To process single family cases
through a new branch, its employees must complete the standard user
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registration for an FHA Connection user ID; then the company’s FHA
Connection Application Coordinator must update each user’s profile to
indicate which application functions the user is authorized to perform.

Sponsor Relations

This function allows governmental, supervised and non-supervised
mortgagees to view, add and delete relationships with loan correspondents.
It also allows loan correspondents to view and delete relationships with
sponsors.

Authorized Agent Relations

This function allows governmental, supervised and non-supervised
mortgagees to view, add and delete designations of other lenders as their
authorized agent for Title II single family originations. It also allows
lenders to view and delete relationships in which they are another lender’s
authorized agent.

HMDA Data Submissions

The Home Mortgage Disclosure Act (HMDA) menu links to screens for submitting
HMDA data. In addition, the lenders will have the ability to retrieve their HMDA Edit
Reports, using their standard user ID, within 24 hours of the submission.

? If you are unable to send or retrieve HMDA data please contact the HMDA
Assistance line at (202) 755-7500 or email tbeckwith@atsva.com.

HMDA Menu

HMDA Internet Data Submission Upload

The HMDA Data Submission File Upload screen allows lenders to send their
HMDA data submissions directly to the HMDA web server for further processing.
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HMDA Data Submission Edit Report Retrieval

The HMDA Data Submission Report Retrieval screen allows lenders who
submitted their data via the HMDA File Upload feature the ability to view or
download their Transaction Edit Status Reports within 24 hours of submission.
Report retrieval is based on the user ID that submitted the data using the HMDA
Data Submission File Upload.

HMDA Data Entry Software Request Form

This link allows the lender to request the CD-ROM version of the HMDA Data
Entry software, which is designed to provide institutions with an automated means
of entering and transmitting HMDA data. In addition to data entry and
transmission, the software allows the user to edit the data, produce status and edit
reports and export error-free data.

Neighborhood Watch

Neighborhood Watch is intended to aid HUD/FHA staff in monitoring lenders and HUD
programs, and aid lenders in self-policing the industry. The system is designed to highlight
exceptions, so that potential problems are readily identifiable.

Currently, the bulk of the system is for early defaults. The system provides the ability to
identify and analyze patterns, by geographic area or originating lender, in loans which
became 90 days delinquent during their first 3 years.

For a lender beginning to analyze its own company, the best place to begin is to order an
Early Warning - Single Lender - By Comparison report, choosing "Lender rolled up to
MSA vs. MSA". This report shows your default rate in each MSA vs. the MSA average
and shows the result as the "compare ratio," with 1 meaning that your default rate equals
the average, 2 meaning your rate is twice the average. If you click on your name in any
row of the report, you can investigate patterns in the types of loans going into default by
choosing "all loan types."

You can also look at patterns across the country or in a specific city, MSA, state or HOC
(these are available under the "By Area" options). You can look at data for your own
company or any other; however, you can only "drill down" to case specifics on loans you
originated, sponsored or serviced.
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? All lender data published in this version of Neighborhood Watch is rolled up to the
institution level (not the branch office level). Data for all branch offices shown in
these reports is aggregated under the 5-digit institution ID/Lender Name.

Neighborhood Watch Menu

Early Warnings

The Early Warnings First Defaults screen allows the user to hone in on the lenders
and geographic areas that exhibit unusually high levels of  first defaults early in the
loan amortization period. There are three first default "periods" offered as options
in Neighborhood Watch. They include:

• Loans that first defaulted within the first year after the beginning amortization
date

• Loans that first defaulted within the first two years after the beginning
amortization date

• Loans that first defaulted within the first three years after the beginning
amortization date

In addition to choosing a default period the focus of a particular search can be
narrowed by area or comparison for single lenders or all lenders.

Analysis

The Analysis Origination & Default/Claim Comparison screen offers a detailed
view of individual performance data. Users can assess comparative performance
measures of any two entities of interest, be they lenders or areas, from a single ZIP
Code up to the nationwide level.

A series of option/selection screens guide the user through the process of selecting
two distinct areas/lenders for comparative analysis. First, the baseline lender or
area is chosen, followed by the "compared to" lender or area.
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Details

The Details option features several report/query functions that permit the user to
quickly access detailed data for Neighborhood Watch-related "entities." Currently,
screens are available for Lenders, Watch Areas and Programs. In the future, Case
Status and other items will become available.

Lender Details

The Lender Details screen generates a detailed profile of any lender that
originated loans that would appear in Neighborhood Watch output (in the
last five years and current year-to-date). The Lender Summary report that
is generated contains important information about the lender, including key
dates, Lender ID, type of lender, home office location, and a listing of all
branch offices.

Watch Area Profiles

The Watch Area Profiles screen displays a listing of all geographic areas
that comprise a given Watch Area. The Watch Areas displayed in the
current list box are predefined areas made up of ZIP Codes in 18 different
MSAs. Additional Watch Areas will be appended as they are requested by
users or other HUD staff.

? Requests for new Watch Areas should be submitted via the Feedback
form. Since Neighborhood Watch data is refreshed monthly, it may
take as long as one month for new watch areas to be incorporated into
the Watch Area selection list box and Early Warning and Analysis
output tables.

Program Profiles

One of the content features of Neighborhood Watch that makes single
family loan data more meaningful in a business sense is the behind the
scenes conversion from ADP code to HUD program. All case data in the
Single Family Data Warehouse (the NW data source) has a single ADP
code associated with it, which is entered at the time of loan
application/endorsement.

In Neighborhood Watch, these ADP codes are translated to one or more
program combinations and/or program roll-ups. The program combinations
and roll-up are what the user sees in all output screens. The Program
Profiles feature shows the translation that occurred in building the
Neighborhood Watch database.
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Default Cases

The Default Cases screen gives authorized users the ability to view, print or
export to Excel case-level data on default cases. Lender employees will be
restricted to viewing the default cases for which their company was/is the
originating sponsoring or servicing lender.

Users can select the lender, area, and one of the following date parameters:
beginning amortization date, closing date, and endorsement date to view
the default cases. The minimum dates will automatically default to the
earliest date for which that selected lender has defaults within the selected
area. Users can view the default history for any listed case by clicking on
the underlined case number in the "Default Cases" report.

? Since the case details contain data covered by the Privacy Act, use of
this feature will be limited to authorized users. Lender employees must
contact the FHA Connection Application Coordinator within their
organization to request access. HUD users should request access via
email to sfadmin@hud.gov. Please provide your first, middle and last
name, your position and office within HUD, location, as well as your
social security number and universal HUD systems ID and an
explanation of why you should be granted access to Default Cases
detailed data.
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Internet Web Browsers

A brief description of Internet web browser functionality follows. Although some features
described are specific to the Netscape browser, the functionality described can easily be
found in the other browsers. There are many sources of information available describing
how to use browsers, including libraries, bookstores, sites on the web, and documentation
accompanying software packages.

Features & Functions of Web Browsers

Browser Window

The browser window is the main area of the screen where the web page displays.

To travel from one web page to another web page, you must select a link. A link is
the doorway to the next page, and can be a selection of text, a button, or a picture.
Within the FHA Connection, links are represented by blue text.

Title Bar

The browser displays the title bar “Netscape - [FHA Connection].” This title
changes as the user moves to other pages. However, the title bar contains three
other features that do not change: a Control menu, Minimize button, and Restore
button.

For Windows 3.1:

For Windows 95:

Menu Bar

To access any of the menu functions, either click on the menu option with the left
mouse button or press a and the underscored letter of the menu option. For
example, to access Edit menu options, press a and E on the keyboard. A menu
of editing options is displayed.
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For more information on each option, go to the Help menu. A description of each
menu option is provided below:

File: The File menu option allows the user to open a New Web Browser
session; create and send a New Mail Message; Open a web site
location; Select a file to open; Save a file that contains current
Netscape contents; Close the current Netscape page; and Exit the
current Netscape application. It also has features that allow the user
to Setup, Preview, and Print the page.

Edit: The Edit menu option allows the user to Undo the last action
performed; Cut, or remove, the current selection and place it on the clipboard;
Copy a current selection to the clipboard; Paste clipboard contents into the
current Netscape page at the position of the selection marker; Select all of a
certain content area; Find a word or phrase within the current Netscape page;
and Find Again another occurrence of the text specified after using Find.

View: The View menu option allows the user to Reload the current
Netscape page to replace the originally loaded page.

Go: The Go menu option allows the user to go back one page and forward
one page. It gives the user the option to Stop Loading a page. This means that
the browser stops looking for a page. It also numerically lists the last 25 pages
by title that were visited by the user. This allows the user to move to different
home pages without having to go back sequentially. All pages are erased from
the Go menu option once the browser is closed.

Bookmarks: The Bookmark menu option allows the user to access designated
home pages or Intranet sites. By choosing Add Bookmark from the
menu option, the user can add the title of the current Netscape page
to the list of pages in the bookmark file. Using bookmarks provides
quick access to frequently visited web sites.

Options: The Options menu allows the user to define settings for Netscape’s
operation. Some setting options include General Preferences, Mail and News,
Network and Security. Selecting Toolbar, Location, and Directory allows the
user to view these menu options on the screen.

Directory: The Directory menu option contains features such as Internet
Search, People, What’s Cool, What’s New. The Internet Search is a tool that
allows a user to find information stored worldwide. What’s Cool lists
interesting Internet web sites. What’s New lists new Internet web sites.

Window: The Window menu option allows the user to switch between open
windows. The Window menu option contains features such as Netscape Mail,
Netscape News, Address Book, Bookmarks, History, and Window Items.

Help: The Help menu option provides assistance for Internet questions.
The Help menu option contains features such as About Netscape,



FHA Connection Guide

03/23/9930

About Plug-ins, Registration Information, Software, Handbook,
Release Notes, Frequently Asked Questions, On Security, How to
Give Feedback, How to Get Support, and How to Create Web
Services.

Toolbar Buttons

The toolbar contains buttons which represent the most commonly used commands.
Although the button bars visually change from web browser to web browser, the
functions are generally the same.

Back Button: The Back button displays the previous page viewed.

Forward Button: The Forward button displays the next page in a sequence of
pages already viewed.

Home Button: The Home button displays the designated home page.

Reload Button: The Reload button displays the newest version of the
information in the current website.

Images Button: The Images button causes images in the current page to be
loaded.

Open Button: The Open button allows the user to access a site by typing the
URL or address of the page (e.g. http//www.hud.gov).

Print Button: The Print button prints the current page of the document.

Find Button: The Find button allows the user to search the displayed text of
the current page for key words.

Stop Button: If the Stop button is red, it allows the user to terminate the
document loading process. If the Stop button is gray, the
document has finished loading.

Location Bar

The Location bar displays the network address of the page currently displayed.
Information can be entered directly into the Location field.
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Scroll Bars

The scroll bars appear whenever there is more information to display in the dialog
box or list box. There are horizontal and vertical scroll bars.

To use the scroll bars:

1. Point and click the left mouse button on the scroll bar arrow for the desired
viewing direction.

2. Continue to click the left mouse button. The information moves in the direction
selected.

Status Bar

The status bar displays many types of information such as the progress of a loading
document. Information that can be displayed includes messages about contacting
the server; the percentage of the document already loaded; the rate at which it is
loading; and what will be loaded after clicking on the linked text or images.
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